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A B S T R A C T   

Deformation behavior of beryllium during compressive loading and cross-reloading is studied 
using in-situ high energy synchrotron X-ray diffraction microscopy and crystal plasticity 
modeling. The evolution of texture, twinning, elastic lattice strains, and flow stress are measured 
and compared with the predictions of an advanced elastic-plastic self-consistent (EPSC) crystal 
plasticity model. The model is initialized with the experimentally measured texture and residual 
stress produced by a simulation of cooling and calibrated to establish a set of model parameters 
using a portion of the measured data. The rest of the measured data is used for validation of the 
model. It is shown that the model is sufficiently flexible to reproduce the particularities pertaining 
to the complex strain-path-change and strain rate sensitive deformation of the material including 
the evolution of texture, twinning, lattice strains, transients in the stress-strain response, and 
anisotropic hardening with great accuracy using a single set of model parameters. From the 
comparison of the experimental data and predictions, we infer that the shifts in active defor
mation mechanisms between the slip systems from soft to hard and vice versa as well as between 
twinning to de-twinning are primarily responsible for drastic changes in the flow stress from one 
path to another. In particular, deformation twins form during compressive in-plane loading fol
lowed either by de-twinning during compressive cross-reloading in the through-thickness direc
tion or by forming additional twin variants with some de-twinning of the existing variants during 
a compressive cross-reloading in another in-plane direction. The shifts in active deformation 
mechanisms are a consequence of changes in texture relative to the compression direction 
mediated with the deformation history and strain rate dependent dislocation density evolution 
governing hardening. The secondary effects improving the predictions come from accounting for 
residual stress, slip system-level backstress, and latent hardening.   

1. Introduction 

Mg, Ti, Zr, Be are hexagonal close-packed (HCP) metallic materials receiving increasing interest for creating alloys for structural 
components, primarily because of their high strength-to-weight ratio. During manufacturing and often in-service, these metals 
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undergo plastic deformation. As a result of plasticity, their microstructure and texture evolve changing their structural properties. The 
deformation of HCP metals is carried out by multiple deformation mechanisms i.e. prismatic, basal, and pyramidal slip, and defor
mation twinning. The relative contribution of these deformation mechanisms to the plasticity depends on crystallographic texture with 
respect to the straining direction, as well as strain rate and temperature of deformation (Christian and Mahajan, 1995; Yoo, 1981). For 
example, increased strain rate and decreased temperature suppress the thermally-activated dislocation glide, while increasing the 
activity of deformation twinning (Knezevic et al., 2013a, 2015; Song and Gray, 1995). Moreover, shifts in the relative activities of slip 
and twinning deformation mechanisms due to new slip systems and twin variants activating and/or prior slip system reversing the 
glide direction and/or twin domains shrinking (de-twinning) occur during strain-path changes. These basic sub-grain-scale processes 
govern the flow stress response in addition to the concomitant microstructural evolution (Brown et al., 2012; Sisneros et al., 2010). 

Microstructure-sensitive models capable of predicting how the thermo-mechanical response of crystalline materials is affected by 
their microstructure and local intrinsic anisotropic constitutive behavior have been the subject of intensive research for several de
cades. A number of models have been developed ranging from Taylor-type upper-bound (Fromm et al., 2009; Knezevic et al., 2009, 
2008; Knezevic and Savage, 2014; Taylor, 1938), mean-field self-consistent (SC) (Feng et al., 2021; Knezevic et al., 2013b, 2016b; 
Lebensohn and Tomé, 1993; Turner and Tomé, 1994) to spatially resolved such as crystal plasticity finite element (Ardeljan et al., 
2014, 2015a, 2016b; Kalidindi et al., 1992; Knezevic et al., 2014; Knezevic et al., 2010; Roters et al., 2010) and Green’s function fast 
Fourier transform formulations (Eghtesad et al., 2018a, 2020; Eghtesad and Knezevic, 2021, 2020b, 2021; Eghtesad et al., 2018d; 
Lebensohn et al., 2012). While the spatial models can be used for detailed simulations accounting for grain-to-grain interactions, the 
Taylor-type and SC models are more computationally efficient and have proven effective in predicting the homogenized flow stress and 
texture evolution of polycrystals. Another important advantage of these models is in the schemes for handling deformation twinning, 
while the explicit incorporation of twinning in the spatial models is challenging (Ardeljan et al., 2017; Ardeljan and Knezevic, 2018; 
Ardeljan et al., 2015b; Knezevic et al., 2016a). Additionally, the Taylor-type and SC crystal plasticity models can serve as constitutive 
laws in the finite element method (FEM) simulations (Jeong et al., 2021; Knezevic et al., 2013c; Prakash et al., 2015; Segurado et al., 
2012; Tomé et al., 2001; Walde and Riedel, 2007; Zecevic et al., 2016a; Zecevic and Knezevic, 2018b; Zecevic et al., 2021). In such 
formulations, the spatial variation in deformation from point to point across the FE model relaxes the intrinsic homogenization as
sumptions (Ardeljan et al., 2016a; Feather et al., 2019, 2021). The development and validation of such material models with sensitivity 
to microstructure and its evolution is critical for engineering analysis and material design, especially with the advent of 
high-performance computing for materials science applications (Eghtesad et al., 2018c, 2020; Eghtesad and Knezevic, 2018; Panchal 
et al., 2013). Modeling the complex deformation behavior of HCP metals requires such sophisticated models based on crystal plasticity 
theory to link crystallographic deformation mechanisms and texture evolution to highly anisotropic material properties (Kocks et al., 
1998). 

The activation of deformation mechanisms in crystal plasticity models is controlled by crystallography of grains relative to the 
sense of loading and by a set of model parameters determining the resistance to slip/twin. These model parameters are calibrated using 
stress–strain curves for a material through a fitting procedure (Savage et al., 2021). Data such as elastic lattice strains and geometrical 
changes upon deformation are used for verification of the parameters. Moreover, microstructural data such as the evolution of texture 
and twinning provide further verification. The advent of techniques such as high-energy synchrotron X-ray diffraction microscopy 
allows for the unprecedented ability to collect in-situ polycrystalline microstructural evolution data for detailed calibration and 
validation of crystal plasticity models (Poulsen, 2004; Shade et al., 2019; Wang et al., 2014). Specifically, the high energy and 
brightness of synchrotron X-rays enables detailed probing of the internal structure within bulk samples during in-situ loa
ding/unloading. An X-ray exposure that probes a given volume of a polycrystal produces reflections for all sampled grains that meet 
the Bragg diffraction criteria. These grains have different neighborhoods and average the diffraction signal. From these reflections, 
information on crystallographic interplanar spacing (d-spacing), crystallite size (size of diffracting volume/crystallite), and crystal
lographic texture can be inferred. When a series of X-ray exposures is collected from a deforming polycrystalline sample, the evolution 
of the mean D-spacing for a given diffracting plane is observed to shift due to the uniform intragranular lattice strains associated with 
elastic deformation. If polycrystalline samples are deformed beyond yield, in-situ X-ray exposures would show diffraction patterns with 
broadening reflections, which result from plasticity-induced, non-uniform lattice strains (micro-strain). Elasto-plastic (EP) SC models 
have been used to interpret lattice strain and macroscopic stress-strain data from these types of in-situ experiments (Clausen et al., 
2008; Wollmershauser et al., 2012; Zecevic and Knezevic, 2015a). Specifically, these models and the corresponding in-situ diffraction 
measurements probe their respective polycrystalline samples in similar ways, which facilitates model validation. 

Models are typically developed and tested in monotonic deformations applied in one direction, whereas in practice, metals usually 
experience frequent changes in strain paths, strain rates, and temperatures. In order to predict the mechanical response and micro
structural evolution of HCP metals during a sequence of two or more strain paths such as compression in one direction under one strain 
rate to a given strain level and then compression in a perpendicular direction under a different strain rate, the model must account for 
phenomena such as residual stress, backstress, reverse glide of mobile dislocations, and de-twinning (Kitayama et al., 2013a; Knezevic 
et al., 2013a; Peeters et al., 2001; Proust et al., 2010; Rauch et al., 2011; Wen et al., 2015a, 2016). The present work is concerned with 
in-situ high-energy X-ray diffraction and crystal plasticity modeling of deformation characteristics during loading and reloading of Be, a 
material much less studied than other HCP metals (Abey, 1970; Blumenthal et al., 2004; Brown et al., 2005b; Kokovikhin et al., 1990). 

A recently developed multi-scale (MS) EPSC model (Zecevic et al., 2015) incorporated several grain- and sub-grain-level models: 
the dislocation density-based hardening law (Beyerlein and Tomé, 2008; Brown et al., 2012), the composite grain (CG) twinning model 
(Proust et al., 2007) improved to nucleate multiple twin domains/twin variants within the same grain, stress fluctuations to influence 
twin nucleation (Niezgoda et al., 2014) and de-twinning. The work presented here advances the MS-EPSC model for HCP metals to 
account for slip system-level backstress, dissolution of dislocations upon strain-path-change, and latent hardening. While the first 
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phenomenon is important for predicting re-yielding i.e. the Bauschinger effect (BE), the latter two phenomena are important for 
predicting change in the hardening rates upon reloading. The advanced MS-EPSC model is applied to a comprehensive set of data 
involving flow stress, texture, twin volume fraction, and lattice strains recorded during fourteen tests each involving a loading path 
followed by a cross-reloading path in compression under different strain rates. While reproducing the data, the model adjusts the 
relative activity of slip-dominated deformation for some strain paths, while slip and de-twinning or slip, twinning, and de-twinning for 
other deformation paths. Remarkably, the model predicts the role of shifts in slip, twinning, and de-twinning on the change in yield and 
flow stresses upon reloading at variable strain rates. Good agreement in predicting the evolution texture, twin fraction in twinning and 
de-twinning is also achieved in every strain path. Finally, the evolution of elastic lattice strains compare well with the data measured 
by means of in-situ high-energy x-ray diffraction during compressive loading and unloading. Furthermore, the essential effects of 
residual stresses, backstress, and reverse dislocation glide on the mechanical response during loading and reloading are predicted and 
discussed. 

2. Experimental methods 

2.1. Material and sample preparation 

The Be used in this study was a rolled plate of 4.8 mm thickness by approximately 0.5 m wide and 2 m long. More details about 
processing of the plate can be found in (Brown et al., 2013). A set of samples, rectangular prisms with dimensions 2.5 mm × 2.5 × mm 
× 4.0 mm, were cut from the plate using electro-discharge machining (EDM). Sample orientation with respect to the frame of the Be 
plate is shown in Fig. 1a: in-plane axes IP1 and IP2 are the rolling and transverse directions, while through thickness (TT) is the plate 
normal direction. These samples were used for mechanical testing along different sample directions. 

2.2. Quasi-static and Split-Hopkinson pressure bar and compressive pre-loading 

Ten samples were pre-strained ex-situ in compression for subsequent in-situ reloading along with X-ray diffraction measurements of 
lattice strains and texture. Four samples were compressed along IP1 to different pre-strain levels at room temperature under a strain 
rate of 10−3 s−1 in an Instron load frame dedicated to the Spectrometer for Materials Research at Temperature and Stress (SMARTS), 
the Lujan Center, LANSCE, Los Alamos National Laboratory (Bourke et al., 2002). Six samples were compressed along IP1 to different 
pre-strain levels at room temperature under a strain rate of 2000 s−1 using a Split-Hopkinson Pressure Bar (Chen and Kocks, 1991; 
Follansbee, 1985). Table 1 summarizes the tests performed on these 10 samples of Be (A-J). Data for the samples K-L is taken from prior 
works involving the same material (Brown et al., 2013). A total of fourteen preload specimens to variable strain levels under variable 
strain rates (0.001 s−1, 5 s−1 and 2000 s−1) is aimed to study mechanical response and microstructural change transients in subsequent 
reloading. 

2.2. High-energy X-ray diffraction experiments 

In-situ X-ray diffraction experiments were performed at the Advanced Photon Source (APS) 1-ID-E beamline, Argonne National 
Laboratory. The schematic of the in-situ experimental setup is shown in Fig. 1b. The X-ray energy was 65.0 keV (wavelength of 0.01907 
nm) and the sample to detector distance was 1100 mm. The instrument was calibrated using a standard CeO2 specimen (Kaiser and 

Fig. 1. (a) Sample orientation with respect to the frame of the Be plate: in-plane axes IP1 and IP2 are the rolling and transverse directions, while 
through thickness (TT) is the plate normal direction. (b) A schematic of the APS 1-ID-E experimental apparatus for collecting X-ray diffraction 
measurements during in-situ loading. The apparatus integrates an MTS servo-hydraulic load frame with dies holding a sample. A compressive force is 
applied on the sample while allowing unobstructed paths for the incident high-energy monochromatic X-rays and outgoing diffracted X-rays. 
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Watters, 2007). Monotonic, displacement-controlled compression tests were carried out at room temperature at a strain rate of 2 ×
10−4 s−1 using an MTS servo-hydraulic load frame. The is-situ loading was performed without a need for holding time. The wide angle 
X-ray scattering (WAXS) data were collected on a single a GE 41RT area detector (Shastri et al., 2002) with 2048 × 2048 pixels (0.2 ×
0.2 mm2 pixel size). Both the WAXS and the MTS load frame data acquisition rates were aligned, making it possible to obtain WAXS 
data as a function of sample displacement or applied load. For these tests, the rectangular parallelepiped samples preloaded along the 
IP1 direction were reoriented by 90◦ and subjected to in-situ reloads either along TT (six samples) or IP2 (four samples). For TT reloads, 
the IP2 sample axis was transverse to the straining direction, and the original straining direction (IP1) was the second transverse 
direction. For IP2 reloads, the TT sample axis was transverse to the straining direction, and the original straining direction (IP1) was 
also the second transverse direction. When strained along TT or IP2 during reloading, incident X-rays entered the sample along IP1. 
These complex experiments are designed to provide data for the interpretation of the interactions between slip and 
twinning/de-twinning and the mechanisms underlying unloading, BE, transients in strength, and subsequent hardening. 

Ex-situ X-ray diffraction experiments were also performed at the APS 1-ID-E beamline for texture. The experimental setup was 
similar to the in-situ setup with the primary exception being that the sample to detector distance was reduced to 680 mm, reducing the 
resolution but increasing the number of hkl’s observed and improving texture analysis. Each ex-situ experiment consisted of 8 separate 
X-ray exposures, which were collected with the sample rotated at different angles (ω = −10◦, 0◦, 10◦, 20◦, 30◦, 40◦, 50◦, and 60◦) about 
the loading axis. An ex-situ experiment for texture analysis was performed once before reloading and once after unloading. 

Table 1 
Compressive strain path change mechanical tests performed on samples of Be.  

Case Preload axis (strain rate) True strain Reload axis (strain rate) Additional true strain 
A IP1 (0.001 s−1) 0.165 TT (0.0002 s−1) 0.0785 
B IP1 (0.001 s−1) 0.095 TT (0.0002 s−1) 0.0584 
C IP1 (0.001 s−1) 0.058 TT (0.0002 s−1) 0.0635 
D IP1 (2000 s−1) 0.144 TT (0.0002 s−1) 0.0934 
E IP1 (2000 s−1) 0.064 TT (0.0002 s−1) 0.0597 
F IP1 (2000 s−1) 0.1 TT (0.0002 s−1) 0.071 
G IP1 (2000 s−1) 0.203 IP2 (0.0002 s−1) 0.1 
H IP1 (0.001 s−1) 0.173 IP2 (0.0002 s−1) 0.116 
I IP1 (2000 s−1) 0.066 IP2 (0.0002 s−1) 0.098 
J IP1 (2000 s−1) 0.097 IP2 (0.0002 s−1) 0.104 
K IP1 (5 s−1) 0.22 TT (5 s−1) 0.15 
L IP1 (5 s−1) 0.22 TT (0.001 s−1) 0.15 
M IP1 (5 s−1) 0.22 IP2 (5 s−1) 0.15 
N IP1 (5 s−1) 0.22 IP2 (0.001 s−1) 0.15  

Fig. 2. (a) High-energy X-ray diffraction pattern of sample B during in-situ loading that shows integration regions for lattice strain analysis. Areas 
outlined in red highlight diffracting planes with poles that are parallel to the loading axis, and areas outlined in blue highlight diffracting planes 
with poles perpendicular to loading. Incident X-rays are along IP1. (b) High-energy X-ray diffraction pattern of sample B during in-situ loading that 
shows integration regions for texture analysis. Incident X-rays are along IP1. 
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3. Data analysis 

3.1. Calculating lattice strains 

A step-by-step guide to the lattice strain analysis performed in GSAS-II using in-situ X-ray diffraction data is provided in 
Appendix A, and only a brief description of the procedure exists here. To ensure accurate lattice strain calculations for Be samples, 
instrument parameters were calibrated in GSAS-II using data collected from the CeO2 standard sample. Once calibrated, regions of the 
two-dimensional WAXS Be diffraction patterns were isolated for analysis. Fig. 2a shows the vertical slices in a Be diffraction image that 
correspond to diffracting planes with poles approximately parallel to the loading axis, and the horizontal slices corresponding to 
diffracting planes with poles approximately perpendicular to loading. The arclength of these slices is 15◦η (i.e. 7.5◦ around the loading 
axis for the vertical arc, while the same around the horizontal axis for the horizontal arc). Horizontal and vertical slices were integrated 
and averaged separately to convert the 2D image data into 1D intensity vs. D-spacing histograms (Toby and Von Dreele, 2013). This 
process, once initialized for a sample, was automatically applied to all diffraction images in the dataset. The histograms corresponding 
to a single X-ray exposure taken before and after in-situ loading are shown in Fig. 3a,b and 3c,d, respectively. Furthermore, the his
tograms in Fig. 3a,c represent diffracting planes with poles perpendicular to loading and the histograms Fig. 3b,d represent diffracting 
planes with poles parallel to loading. 5 Be reflections were captured ({1010}, {0002}, {1011}, {1012}, and {1120}). These peaks were 
fit in GSAS-II, 2θ values were converted to D-spacing, and lattice strains were calculated using the method discussed in Brown et al. 
(2003). The reference D-spacing for lattice strain calculations was measured from an uncompressed sample of Be that originated from 
the same plate as other samples. Consequently, the calculated lattice strains are with respect to the hot-pressed and machined state of 

Fig. 3. Histograms created by integrating horizontal and vertical slices of a diffraction pattern collected (a,b) before and (c,d) after in-situ loading. 
The horizontal and vertical slices of the diffraction pattern that were integrated represent diffracting planes with poles (a,c) perpendicular and (b,d) 
parallel to loading, respectively. Five Bragg reflections are observed for metallic Be, and peaks from various Be oxides can also be seen (especially at 
higher D-spacings). Be oxides is approximately 2%. 
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the uncompressed sample. Therefore, since the calculated lattice strains do not account for thermal residual strains left from the 
processing of the plate, they should be referred to as mechanically-induced lattice strains (Brown et al., 2003). 

3.2. Calculating crystallographic texture 

A step-by-step guide to the texture analysis performed in Maud using ex-situ X-ray diffraction data is provided in Appendix A, and 
only a summary is given in this section. The Maud diffraction analysis software was used to convert all X-ray diffraction images 
collected for texture analysis into histograms, which were then analyzed. The models governing the calculated diffraction histograms 
in Maud are described in references (Alves et al., 2015; Matthies et al., 1997; Wenk et al., 2003) and incorporate effects of sample 
geometry, instrumentation, and material structure on the intensity and shape of Bragg reflections. 

The 8 diffraction images corresponding to the 8 sample rotation angles (ω) at which X-ray exposures were taken were binned into 
72 regions (with arclengths of 5◦Φ), each of which was integrated and converted into a 1D intensity vs. D-spacing histogram. The 
Rietveld method was applied whereby the relevant crystallographic and scaling parameters were refined to increase the quality of the 
least-squares fit between calculated and experimental diffraction histograms. An orientation distribution function (ODF) was calcu
lated from the 576 histograms, which provide intensity data on all diffracting planes as a function of ω and Φ angles. The Rietveld 
refinement method used for texture analysis in Maud is based on the work in (Wenk et al., 2010). 

3.3. Calculating twin volume fractions from crystallographic texture 

Since no spatial characterization of the material was possible, twin volume fractions were estimated after characterizing texture 
evolution as the volume fraction of crystal orientations with c-axis close to the compression direction (Bhattacharyya et al., 2016; 
Brown et al., 2005a; Feather et al., 2019; Jain and Agnew, 2007). The underlying assumption is that tensile twins reorient texture 
strictly toward the compression direction and there is minimal reorientation due to slip induced lattice spin. A misorientation cutoff 
angle of 30◦ between the compression direction and c-axis was utilized to identify the twin volume fraction per sample after defor
mation. The method does not account for any secondary twins, which may develop in primary twins. 

4. Modeling framework 

The deformation behavior of Be is modeled using a recently developed MS-EPSC (Zecevic et al., 2015), which incorporates several 
sub-models: the dislocation density-based hardening law (Beyerlein and Tomé, 2008), the composite grain (CG) twinning model 
(Proust et al., 2007) improved to nucleate multiple twin domains/twin variants within the same grain, stress fluctuations influencing 
twin nucleation (Niezgoda et al., 2014) and de-twinning. Specifically for modeling of strain-path-change deformation of Be, the model 
is improved to account for dissolution of dislocations upon reloading, slip system-level backstress, and latent hardening, taking ad
vantages of the work presented in (Barrett et al., 2020). Combining these sub-models into one advanced version of MS-EPSC enables 
modeling of strain-path and strain rate sensitive deformation of the highly anisotropic response of Be. A summary of the modeling 
framework is presented next. 

In the description that follows, “ • “ represents the dot product, while “ ⊗ ” represents the tensor product. Also, bold letters are used 
for tensors, while tensor components and scalars are italic but not bold. A family of slip systems (slip mode) is denoted with “α", while 
an individual slip system belonging to a family is denoted with “s”. Moreover, the notation distinguishes between positive s+ and 
negative s- slip system directions for every s. Likewise, a twin mode is denoted with “β” and twin systems with “t”. 

In SC modeling, the polycrystalline material is represented using a set of ellipsoids, where each ellipsoid is a grain, which is treated 
as an elasto-plastic inhomogeneity embedded in a homogenous-effective-medium (HEM). The inhomogeneity inclusion interacts with 
the HEM in an average sense (Lipinski and Berveiller, 1989; Zecevic and Knezevic, 2019). The averaged rate of Jaumann stress and 
strain rate over constituent grains is that of the HEM: σ̂ =< σ̂c

> and ε̇ =< ⋅εc > (Neil et al., 2010). 〈〉 denotes volume average. The 
following linearization relations are employed to relate overall- (polycrystal-) and grain-level (the superscript “c” denotes grain- or 
crystal-level) constitutive quantities 

σ̂ = L⋅ε, (1)  

σ̂c
= Lcε̇c

, (2) 

The rate of Cauchy stress can be readily obtained from the rate of Jaumann stress using ⋅σ = σ̂ + 〈Wcσc〉 − 〈σcWc〉 = L⋅ε + 〈Wcσc〉 −

〈σcWc〉. In this relationship, Wc is the grain c spin tensor. The overall and grain strain rates are related through a localization tensor, Ac 

⋅εc = Acε̇. (3) 

The localization tensor Ac is calculated based on an instantaneous grain-level elasto-plastic stiffness, Lc, and that of the polycrystal, 
L, 

Ac =
(
Lc + Lc∗ )−1(

Lc∗

+ L
)

with Lc∗
= Meff L

(
Sc−1

− I
)
. (4) 

In Eq. (4), Lc∗ is the effective stiffness governing the interaction between the grain and overall quantities: (σ̂c
− σ̂) = − Lc∗

(ε̇c
− ε̇), 

Sc−1 is the symmetric Eselby tensor (Eshelby, 1957), and I is the 4th rank identity tensor. The parameter Meff can be used to tune 
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strength of the interaction between inclusions and HEM (Savage et al., 2020; Tomé, 1999) but is set to 1 in the present work. Finally, L 
becomes L = 〈LcAc〉〈Ac〉

−1. 
The constitutive relation at the grain-level is: σ̂c

= Cc(⋅εc − αcṪ −
∑

smc,s γ̇c,s) − σctr(⋅εc). Then, the grain-level instantaneous 
stiffness is 

Lc = Cc − Cc
∑

s
mc,s ⊗

(
∑

s’

(Xss’
)

−1mc,s’
(Cc − σc ⊗ i)

)

− σc ⊗ i (5)  

where 

Xss′

= hss′

+ hss′

bs + Cc ⋅ mc,s ⊗ mc,s′

. (6) 

In the above equations, Cc is the grain-level elasticity tensor calculated based on the single crystal elastic constants and crystal
lographic orientation and mc,s = 1

2 (bc,s ⊗ nc,s +nc,s ⊗ bc,s) is the Schmid tensor for slip system s. The unit Burgers vector, bc,s, and plane 
normal, nc,s, are the geometry of slip system, s. In Eq. (6), hss′ and hss′

bs are the hardening matrix and the back-stress matrix, respectively. 
Expressions for these matrices are defined based on a hardening law and a back-stress law as derivatives with respect to the shear rate, 
γ̇s: hss′

=
∂τs

c
∂γs′ , hss′

bs =
∂τs

bs
∂γs′ (Ghorbanpour et al., 2020, 2017; Zecevic and Knezevic, 2018a; Zecevic et al., 2019b):. The laws are described 

below. 
For the activity of a deformation system, two conditions are: (1) mc,s ⋅ σc − τc,s

bs = τc,s
c and (2) mc,s ⋅ σ̂ c

− τ̇c,s
bs = τ̇c,s

c , where τc,s
bs is the slip 

system backstress and mc,s ⋅ σ̂c is the shear stress resolved on the slip system. The conditions imply that the shear stress resolved on the 
system after the backstress correction must be on the yield surface and must remain on it as it evolves. The evolution laws for slip and 
twin resistances drive the evolution of the crystal yield surfaces. The kinematic effects at the system level are introduced by backstress. 
Therefore, the crystal yield surfaces for slip evolve with deformation through the slip resistance, τc,s

c , and shifts through the backstress, 
τc,s

bs . The resistance and backstress terms evolve with the shear rates using 

τ̇c,s
c =

∑

s′

hss′ γ̇c,s′

, τ̇c,s
bs =

∑

s′

hss′

bs γ̇c,s′

. (7) 

The spin tensor per grain, c, is 

Wc = W + Πc − Wp,c, (8)  

where W is an imposed spin over the polycrystal, Πc is the antisymmetric Eshelby tensor (Lebensohn and Tomé, 1993), and Wp,c =

∑

s
qc,sγ̇c,s is the plastic spin with qc,s = 1

2 (bc,s ⊗ nc,s − nc,s ⊗ bc,s). 

4.1. Deformation history dependent hardening law 

The dislocation density-based hardening law advanced in the present work was originally developed for HCP Zr in Beyerlein and 
Tomé (2008) and then used for other HCP metals including Be (Ardeljan et al., 2015a; Knezevic et al., 2013a). According to this law 
formulation, the resistance to slip, τα

c , consists of the initial slip resistance, τα
0, which is thought to represent the Peierls stress and the 

initial density of dislocations; the Hall-Petch-like barrier term due to presence of twins, τs
HP, which is dependent on the mean free path 

distance reduced from the grain size by the presence of twins; the strain rate and temperature sensitive resistance due to forest 
dislocation density, τs

forest ; and the strain rate and temperature sensitive resistance due to dislocation debris, τα
deb 

τs
c(ε̇, T) = τα

0 + τs
HP + τs

forest(ε̇, T) + τα
deb(ε̇, T). (9) 

The initial value is fitted, while the remaining terms are calculated using 

τα
0,HP = μαHPα

̅̅̅̅̅
bα

dg

√

, (10a)  

τs
forest = bαχμα

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s′

Lss′ ρs′

tot

√
, (10b)  

τα
deb = 0.086 μαbα ̅̅̅̅̅̅̅̅ρdeb

√
log

(
1

bα ̅̅̅̅̅̅̅̅ρdeb
√

)

. (10c) 

Therefore, the assumed additive decomposition of slip resistance represents the actual physical background and facilitate the 
formulation of hardening through the evolving terms. In Eq. (1), χ is a dislocation interaction parameter usually set to 0.9 (Lavrentev, 
1980; Zecevic and Knezevic, 2018a), ρs

tot is the slip system level total forest density of dislocations, ρdeb is the debris dislocation density, 
μα is the shear modulus per slip mode, bα is the Burgers vector per mode, and Lss′ includes a set of latent hardening constants. 
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While the Hall–Petch-like barrier hardening effect due to grain size, τα
0,HP, is included in the initial slip resistance, such hardening 

arises additionally from subdivision of grain due to twinning. The barrier effect due to twinning is formulated as (Knezevic et al., 2015) 

τs
HP =

f PTS − f PTS,0

f PTS,max − f PTS,0μαHPα

̅̅̅̅̅̅̅̅
bα

ds
mfp

√

, (11)  

where ds
mfp =

(1−fPTS)dc
sin(λ)

is the mean-free-path. Here, λ is the angle formed by the slip plane and the plane of the twin. The latter plane is 

that of a selected predominant twin system (PTS) if multiple twin variants form in the given grain. The remaining constant, dc =
dg

nlamellas, 
is the distance between twin lamellae calculated using the grain size, and a chosen number of lamella developing per grain, nlamellas, 
which is taken to be 4. The barrier factor (BF), fPTS−fPTS,0

fPTS,max−fPTS,0 includes two constants, fPTS,max and fPTS,0, standing for the maximum fraction 
and the minimum fraction that twins could occupy, while fPTS is the current fraction of the PTS in that grain. The Hall-Petch-like barrier 
law activates only in the grains containing twins. 

In the hardening law formulation, the total density of dislocations consists of 

ρs
tot = ρs

for + ρs+

rev + ρs−

rev, (12)  

where ρs+

rev and ρs−

rev are the reversible densities of dislocations on the s+ and s−and ρs
for is the forward population. Such split of densities 

introduces directionality in the hardening law and deformation history dependence. The idea of reversible dislocations was originally 
implemented in a visco-plastic SC model, which neglects the elastic strain development (Kitayama et al., 2013a; Knezevic et al., 2013a; 
Mahesh et al., 2004; Rauch et al., 2011). The evolution with shearing strain is (Kitayama et al., 2013a; Kocks and Mecking, 1981) 

(If dγs+

> 0) 

∂ρs
for

∂γs = (1 − p)kα
1

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s’

gss’ ρs’
tot

√
− kα

2 (ε̇, T)ρs
for, (13a)  

∂ρs+

rev

∂γs = pkα
1

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s’

gss’ ρs’
tot

√
− kα

2 (ε̇, T)ρs+

rev, (14a)  

∂ρs−

rev

∂γs = −kα
1

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s’

gss’ ρs’
tot

√ (
ρs−

rev

ρs
0

)m

, (15a) 

(If dγs−

> 0) 

∂ρs
for

∂γs = (1 − p)kα
1

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s’

gss’ ρs’
tot

√
− kα

2 (ε̇, T)ρs
for, (13b)  

∂ρs+

rev

∂γs = −kα
1

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s’

gss’ ρs’
tot

√ (
ρs+

rev

ρs
0

)m

, (14b)  

∂ρs−

rev

∂γs = pkα
1

̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅̅∑

s’

gss’ ρs’
tot

√
− kα

2 (ε̇, T)ρs−

rev. (15b) 

The material in the initial conditions is assumed to contain ρs
for(γs = 0) = ρs

0,for, while ρs+

rev(γs = 0) and ρs−

rev(γs = 0) are set to zero. The 
content approximates an annealed material. Plots illustrating the dislocation populations will be provided later. 

In the above equations, kα
1 is a fitting parameter controlling the rate of generation, while kα

2 is a strain rate and temperature sensitive 
parameter controlling the recovery of stored dislocations (Beyerlein and Tomé, 2008). The parameter p controls reversibility i.e. 
separates the portion of reversible and forward densities in the total dislocation density. The parameter ranges between 0 and 1. The 
value of 1 means a large fraction of reversible dislocations in the total density. The large fraction of reversible dislocations is the likely 
scenario in case of low content of dislocation debris (Khadyko et al., 2016; Kitayama et al., 2013a; Kocks et al., 1991; Teodosiu and 
Raphanel, 1991). gss′ can provide flexibility to account for interactions but is taken as an identity. m governs the rate of dislocation 
recombination (Wen et al., 2015b). ρs

0 is the density of dislocations at the path reversal for the given system s. The parameter kα
2 is 

calculated using (Beyerlein and Tomé, 2008) 

kα
2

kα
1

=
χbα

gα

(

1 −
kBT

Dα(bα)
3 ln

(
ε̇
ε̇0

))

. (16) 

In the above equation, kB is the Boltzmann constant, ε̇0 = 107 s−1 is taken as a reference strain rate, gα is an effective activation 
energy, and Dα is the drag stress (Risse et al., 2017; Tam et al., 2020, 2021). Finally, the debris evolves using (Beyerlein and Tomé, 
2008) 

N.C. Ferreri et al.                                                                                                                                                                                                      



International Journal of Plasticity 150 (2022) 103217

9

∑

s

∂ρdeb

∂γs =
∑

s
qαbα ̅̅̅̅̅̅̅̅ρdeb

√ k2(ε̇, T)ρs
tot. (17) 

In the above equation, qα is a recovery rate fitting parameter. The parameter separates the accumulated debris portion of dislo
cations from those annihilated. 

4.2. Twinning and de-twinning 

Formation of twins influences the microstructure evolution because the twinned domain reorients the crystal lattice orientation 
relative to the parent grain and the domain introduces a twin-matrix boundary (Beyerlein et al., 2014; Christian and Mahajan, 1995). 
These changes influence deformation mechanisms and dislocation processes in the microstructure and so the overall flow stress 
response. The twin-matrix boundaries can hinder slip, which is the barrier effect modeled using Eq. (11). The twin lattice reorientation 
effects are explicitly accounted for. The twinning is modeled as a pseudo-slip process while the shearing does not involve lattice 
reorientation (Chin and Mamme, 1969). Once the shearing accumulates to a threshold of 0.01, the pseudo-slip is followed by the 
reorientation via either the predominant twin reorientation (PTR) method (Van Houtte, 1978) or the volume fraction transfer (VFT) 
method (Tomé et al., 1991) or the Lagrangian method (Kalidindi, 1998) or the composite grain (CG) method (Proust et al., 2007). The 
approach to twining in EPSC is the CG method but extended from the original work to consider multiple twin variants in grains. In the 
CG model, the twin is considered as a separate ellipsoid, and volume is moved from the parent to the twin with pseudo-slip. 

In order to circumvent that every twin variant in grains correspond to the one with the highest Schmid factor, twin variant 
nucleation in the model is influenced by fluctuations in stress concentration following the work presented in (Niezgoda et al., 2014). A 
fluctuating stress tensor, σc,fluct , is added to the criterion for activation per twin system t 

mt ⋅ σc + σc,fluct = τt. (18) 

Components of σc,fluct are sampled from a multivariable normal probability distribution model using a zero mean, σf ,mean, and a 
standard deviation defined as a function of the equivalent stress, σeq, scaled by the standard deviation parameter σeq /σf ,SD for normal 
and σeq/(2.5σf ,SD) for shear stress components. The fluctuations have no effect after a twin variant is tagged to nucleate. Subsequent 
growth of the twinned domain is governed by the hardening law with also no contribution from fluctuations. The stress in the initially 
formed twinned domain is set according to the finite initial fraction (FIF) scheme (Clausen et al., 2008). The FIF scheme sets the stress 
to the difference between a stress calculated using the elastic deformation corresponding to the plastic shear caused by twin formation 
and the stress in the parent grain. 

The volume fraction increment for a twinning system evolves using 

Δf t =
Δγt

S
, (19)  

where Δf t is the increment, while Δγt is the shearing and S is the intrinsic twinning shear, which is 0.189 for Be (Yoo, 1981). The 
resistance to twin for a variant t, in a mode β is 

τt
c = τβ

0 + τt
HP + τβ

slip, (20)  

where, τβ
0 is the mode initial twin resistance, τt

HP is the system barrier term, and τβ
slip is the hardening term due to interaction with 

dislocations. The barrier term for twinning is defined the same way as for slip. The hardening term is 

τβ
slip = μβ

∑

s
Cαβ(ε̇)bβbαρs

tot, (21)  

where Cαβ(ε̇) is the fitting slip/twin interaction matrix. 
Upon cross-reloading, de-twinning can take place. In our approach, de-twinning of a given twin variant in the parent ellipsoid 

occurs by the activation of the same twin variant inside the twinned domain. Therefore, instead of forming a secondary twinned 
domain, the volume of the twinned domain that should be occupied by this secondary twin is transferred from the twinned domain 
back to the parent. However, de-twinning inside the primary twin is allowed to activate in both positive and negative shearing di
rections as in (Wang et al., 2012). The de-twinning resistance is reset and the hardening of de-twin is modeled the same way as for 
primary twin using the established parameters. This implies that the Hall-Petch-like term has the opposing effect on the hardening 
during de-twinning from that during twinning. The parent grain softens, while the twin hardens with the volume evolution during 
de-twinning. The only difference pertains to the calculation of the mean-free-path inside twins: ds

mfp =
fPTSdc
sin(λ)

. 

4.3. Backstress law 

Backstress in polycrystalline metals governs primarily the unloading and BE characteristics of deformation behavior during cyclic 
plasticity. Interactions between grains of different crystallography and incompatibilities between hard and soft regions inside grains 
give rise to backstress (Kassner et al., 2013; Mughrabi, 1983). Backstress acts in the direction opposite to the applied stress during 
loading (Withers and Bhadeshia, 2001). However, the backstress and applied stresses combine quickly when the loading direction is 

N.C. Ferreri et al.                                                                                                                                                                                                      



International Journal of Plasticity 150 (2022) 103217

10

reversed. Drop in the yield stress upon reversal is a signature of backstress. The role of backstress on the flow stress change in 
cross-reloading or any other strain-path-change other than reverse loading is smaller. The EPSC model is formulated to account for the 
elastic interactions between individual grains and HEM. A phenomenological law to account for backstress inside grains in EPSC is 
summarized next. 

The law captures kinematic hardening effects per slip system (Feng et al., 2020; Harder, 1999; Zecevic and Knezevic, 2015) 

τs
bs = ms ⋅ σc

bs = 2
∑

s’

ms ⋅ ms’ τs’

bs,sys∗, (22)  

where 

τs′

bs,sys∗= {
τs′

bs,sys if τs′

bs,sys > 0

0 if τs′

bs,sys < 0
. (23) 

In these equations, σc
bs is the grain-level backstress tensor formed by summing over the slip system backstress sources. The slip 

system backstress is 
(if dγs+

> 0 and τs+

bs,sys > 0) 

τs+

bs,sys = τsat
bs (1 − exp(−νγs+

)), (24)  

τs−

bs,sys = −Aτs+

bs,sys, (25) 

(if dγs+

> 0 and τs+

bs,sys < 0) 

τs+

bs,sys = −(A + 1)τsat
bs exp

(

−
γs−

γb

)

+ τsat
bs , (26)  

τs−

bs,sys = −
1
A

τs+

bs,sys. (27) 

Calibration parameters pertaining to the above phenomenological law include a saturation term, τsat
bs , a constant A to enable an 

asymmetric evolution of backstress in directions s+ and s-, additional fitting constants γb and ν, and γs is the shearing strain at the point 
of strain-path-change. Note that the backstress matrix, hss′

bs , is derived from these equations. Note that τs+

bs opposes the driving force in s+: 
mc,s+ ⋅ σc − τc,s+

bs = τc,s
c , which means that τc,s+

bs reduces the driving force. In contrast, τc,s−

bs aids the driving force in s−: mc,s− ⋅ σc − τc,s−
bs =

τc,s
c . Plots illustrating the effects will be provided shortly. 

The above phenomenological description of slip system-level kinematic hardening effects have proven suitable to capture the 
phenomena governing nonlinear unloading and the BE in cyclic loading of steels (Zecevic et al., 2016b), Al alloys (Barrett and Kne
zevic, 2019), and orthorhombic uranium (Barrett et al., 2020). In think work, we use the law to model loading and cross-reloading of 
Be. 

5. Results 

Fig. 4 shows pole figures of the initial texture in the Be plate. The texture is relatively sharp with c-axis predominantly aligned with 
the TT direction and slightly tilted towards IP1. The measured texture is represented using 500 weighted orientations for modeling 

Fig. 4. Pole figures showing the initial texture in the rolled plate of Be.  
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using the texture compaction procedure described in Barrett et al. (2019), Eghtesad et al. (2018b) and Knezevic and Landry (2015). 
Pole figures based on the 500 weighted orientations used in the simulations are indistinguishable from the pole figures showing the 
measured data and are not shown. Given the texture, grains are favorably oriented for twinning and prismatic slip in compression 
along IP1, while for pyramidal slip in compression along TT. Nevertheless, basal slip is likely to operate in both of these loading 
scenarios because it is the softest deformation model in Be. The initial grain size in the material is 25 µm (Brown et al., 2012). 

Plastic deformation of Be at room temperature is carried out by basal slip {0002}〈1120〉 as the easiest to activate slip systems, by 
prismatic slip {1010}〈1210〉 requiring a higher activation stresses, and by pyramidal 1st order {1011}〈1123〉 and 2nd order {2112}〈

2113〉 slip systems, which are the most difficult to activate (Aldinger, 1979; Jonsson and Beuers, 1987; Poirier et al., 1967). The 
material can also deform by extension twinning, {1012}〈1011〉, the most common twin in HCP metals (Beyerlein et al., 2014; 
Christian and Mahajan, 1995; Partiridge, 1967). These twins re-reorient the basal pole for 84.4◦ from perpendicular to parallel with the 
compression direction. As a result of such texture changes, fraction of twinning can be estimated from texture measurements (Brown 
et al., 2012; Feather et al., 2019). These four deformation modes are made available per grain in the MS-EPSC model for modeling 
plastic deformation of Be. 

The simulations began with a cooling step to estimate the initial stress state in the grains using a crystal thermal dilatation tensor for 
Be consisting of α11 = 12.42 × 10−6 K−1, α22 = 12.42 × 10−6 K−1, α33 = 9.881 × 10−6 K−1. The dilatation tensor components are used 
to estimate the initial state of thermal inter-granular residual stresses using Hooke’s law at the crystal-level σ̂c

= Cc(ε̇c
− αcṪ), 

assuming a uniform temperature rate over the polycrystal of Ṫ = 80 K per increment in time. Note that Cc and αc are dependent on 
crystal orientation of grain c, in addition to crystal constants. An equivalent linear relation at the polycrystal level is σ̂ = C(ε̇ − αṪ). 
The cooling is performed from 850 K processing temperature to 300 K. The subsequent strain-path-change deformation sequence is 
performed after only adjusting the boundary conditions to simple compression with none of the microstructural variables or residual 
stress reset. The compression boundary conditions are uniaxial along the loading direction along with the traction-free surfaces in the 
orthogonal directions. The loading direction was adjusted for the cross-reloading boundary conditions, while preserving the micro
structure, state variables, and residual stress field. 

Fig. 5 compares measured and simulated true-stress-true strain response for the fourteen loading and cross-reloading scenarios 
(Table 1). To calibrate the model parameters, B, E, J, K, and N loading sequences were used. These loading sequences sufficiently 
covered the range of imposed loading directions, pre-strain levels, and strain rates to establish the parameters. For example, the 
loading conditions in B are like those in A. One is sufficient for fitting, while the other can be used for verification. Likewise, the loading 

Fig. 5. Measured (Exp.) and simulated (Sim.) true stress-true strain response of Be during ex-situ pre-loading and in-situ reloading. Although 
compressive, the stress and strain are plotted as positive. 
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conditions in E are similar to those in D and F. Adding more loading sequences to the parameter identification procedure did not 
change the parameters appreciably i.e. did not influence the quality of fits. The remaining tests are not part of the fitting procedure but 
predictions. Overall, the achieved agreement for all tests is good. The high strain rate stress-strain curves are slightly overpredicted, 
which is attributed in part to not modeling softening due to adiabatic heating. As can be seen, some experimental results are missing in 
the figure. The specimens in A, G, and H were successfully deformed to the given strain levels under the given strain rates but load was 
not recorded. The predictive accuracies for the stress-strain curves in A, D, and F are not as good as for the other conditions. The 
loading sequences in A, B, and C are different only in the pre-strain level. However, the experimental stress-strain curve upon reloading 
in A is more compliant than those in B and C. Therefore, the poor prediction in the A sequence is attributed to the experimental setup 
recording a more compliant curve than the real material behavior as in B and C. Poor predictions in the loading sequences D and F are 
due to the texture evolution, which is governed by the rate of de-twinning. The predicted rate for these conditions is slower than in the 
experimental measurements, as will be elaborated shortly. 

Table 2 presents the model parameters established for Be. The parameters identified for Be are the initial resistance to slip, τα
0, 

trapping rate coefficient, kα
1, drag stress, Dα and activation barrier for de-pinning, gα, per slip mode and the initial resistance to twin, τβ

0, 
interaction matrix, Cαβ, and Hall-Petch parameter HPβ per twinning mode. The identification procedure started by varying τα

0 and τβ
0 to 

reproduce onset in yielding. Next, kα
1, was varied such that the initial hardening slopes are captured. Next, gα, Dα, HPβ, and Cαβ are 

varied to match the latter hardening rates. Finally, qα was fit to capture the later stage in the hardening rates. Concurrently with the 
hardening parameters, the backstress law parameters were identified. These included the saturation value for backstress τsat

bs , asym
metry factor, A, and coefficients ν and γb. τsat

bs and A were varied to improve the yield after strain-path change. Once these were 
achieved, tuning ν and γb simply provides better fits. The table also presents the Burgers vectors and the initial dislocation density. 
Additionally, the crystal elastic constants for Be are: C11 = 292.3 GPa, C12 = 26.7 GPa, C13 = 14.0 GPa, C33 = 336.4 GPa, and C44 =

162.5 GPa (Kocks et al., 1998). Based on these crystal constants, shear modulus for prismatic slip is 132.8 GPa, for basal slip is 162.5 
GPa, for pyramidal slip is 152.3 GPa and for extension twinning is 150.3 GPa. 

Fig. 6 shows basal pole figures depicting the measured and simulated texture evolution after preloading and cross-reloading 
compression tests. The basal pole intensity forms along the initial IP1 compression direction as a signature of deformation twin
ning activity. Upon cross-reloading in the TT direction the initial twins along IP1 are depleted due to de-twinning. However, basal pole 
density forms upon cross-reloading in the IP2 direction due to twinning, while the formed intensity is slightly depleting due to de- 
twinning. As is evident, the calculated texture evolution achieves excellent agreement. Comparison of the pole figures is inherently 
qualitative. To make a quantitative comparison between the experiment and simulation, Fig. 7 shows the evolution of the twin volume 
fraction after pre-loading and after cross-reloading for ten in-situ tests. Strong strain rate dependence of the twin volume fraction can be 
inferred. More detailed evolution of twin volume fraction is measured and simulated for the sample K. Overall, the model can be 
regarded as capable of capturing the evolution of twin volume fractions. However, the predictive accuracies vary amongst the loading 
sequences. While the model successfully predicts a substantial amount of extension twinning activity after the pre-compression along 

Table 2 
Model parameters for the evolution of slip system and twin system resistances in Be. Self-interaction (Lαα) and planar interaction latent hardening 
(Lαα/prime ) constants are set to 0.15, while the rest of the latent hardening interactions are small and therefore set to zero according to (Bertin et al., 
2014).  

Slip systems α = 1 
Prismatic  

α = 2 Basal  α = 3 Pyramidal  

bα [m] 2.28 × 10−10  2.28 × 10−10  4.24 × 10−10  

gα  9.75 × 10−3  5.75 × 10−3  4.5 × 10−3  

kα
1 [m−1] 2.5 × 108  0.15 × 108  1.6 × 109  

Dα [MPa] 600 450 650 
ρα

0,for  1.5 × 1012  1.5 × 1012  1.5 × 1012  

τα
0 [MPa] 110 25 233 

HPα  0.05 0.02 0.02 
qα  5 6 0 
Twin system   Cαβ   

bβ [m] fPTS
0  fPTS

max  τβ
0 [MPa] HPβ  α = 1  α = 2  α = 3  

β = 1  2.64 × 10−11  0.05  0.95  331 0.2  3500 −

100ln
ε̇

1s−1  

1100 −

100ln
ε̇

1s−1  

1400 −

100ln
ε̇

1s−1  

De-twin    30 0.2  30 30 30 
Backstress 

parameters 
τsat

bs [MPa] v  γb  A   

20 1 0.001  10 
Fluctuating stress σf ,mean  σf,SD  Reversible dislocations 

constants 
p  m   

0 10  1.0  0.5   
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Fig. 6. {0001} pole figures showing the crystallographic texture evolution in the samples of Be after preloading and after reloading. Pole figures 
were calculated from ODFs that were generated in Maud using the E-WIMV texture algorithm when performing a full texture analysis on the 576 
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histograms created by integrating the 2D X-ray diffraction patterns collected for each sample at each of the 8 rotation angles. Pole density is plotted 
in units of multiple of a random distribution (m.r.d.). 

Fig. 6. (continued). 
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IP1 under 2000/s strain rate, the predictive accuracies of the twin volume fractions after cross-reloading for the D, E, and F cases are 
worse than the other cases. These cross-reloading deformation cases along the TT direction are characterized by substantial de- 
twinning. The model favors rather slip over de-twinning. The relative activities of deformation modes are direct consequences of 
underlying resistances. If resistances to slip were predicted higher than achieved in the model, then de-twinning would be easier. Given 
that we established a set of model parameters providing the best compromise in predicting all the data, improvements of the model 
such as accounting for spreads in the field variables over ellipsoids are necessary to improve these predictions. In the present model, a 
single value is assumed for a given field across the entire ellipsoid. Such spreads have been incorporated in a visco-plastic SC (VPSC) 
formulation and the predictive characteristics have improved (Lebensohn et al., 2016; Zecevic et al., 2020, 2018, 2019a; Zecevic et al., 
2017). 

Finally, Fig. 8 shows measured and predicted evolution of elastic lattice strains for the ten in-situ tests. Lattice strains calculated 
from diffracting planes with poles parallel and perpendicular to loading are distinguished as are those from sample loading and 
unloading. Accuracy of the calculated lattice strains is a function of the peak-fitting accuracy in GSAS-II. When diffraction peaks have 
low intensity there are few diffracting volumes being measured and peak position can be difficult to determine. The error associated 
with peak position propagates through to the lattice strains calculated for a given diffracting plane. It also should be noted that peak- 
fitting accuracy evolves with strain i.e. with texture changes. For example, de-twinning causes the basal poles originally oriented along 
the IP1 to reorient along the TT; therefore, because {0002} diffracting volumes increase in number with cross-reloading compression 
in TT, {0002} peaks are easier to fit for the diffracting planes with poles along TT after cross-loading. Nevertheless, the lattice strains 
evolve relatively linearly in the loading direction, while very little in the perpendicular direction. This is a unique feature of Be because 
of nearly zero Poisson’s ratio. Although certain nonlinearities appearing during unloading in most of the experimental results are not 
present in the simulation results, we regard these predictions as good. In particular, the magnitude in stress versus strain and trends in 
the loading direction versus the perpendicular direction are captured by the model. These predictions signify that the residual stress 
fields should be predicted accurately. 

Fig. 7. (a) Comparison of measured and predicted twin volume fraction in the A-J samples of Be after preloading and after reloading. (b) Com
parison of measured and predicted evolution of the twin volume fraction during the deformation of the sample K. The measurements during the 
reload in (b) are based on in-situ integrated {0002} peak intensities taken from (Brown et al., 2013). 
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Fig. 8. Measured and predicted evolution of lattice strains for several diffracting planes in the A-J samples with poles parallel (blue) and 
perpendicular (red) to the loading direction. Solid circles are the experimental loading path, while the hollow circles are the experimental unloading 
path. Solid lines are simulated loading, while the dash lines are simulated unloading. These hkl-specific lattice strains were measured via X-ray 
diffraction during in-situ compressive loading and unloading. Sign of stress and lattice strain is changed from negative to positive. The error bars 
indicate the average uncertainty in each experimentally-determined lattice strain dataset. 
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6. Discussion 

This work has advanced a formulation of the EPSC crystal plasticity modeling framework termed the MS-EPSC model to interpret 
the deformation behavior of Be. The studied material deforms by multiple slip modes having different resistances to activation and 
deformation twinning, thereby providing a challenging test for the model, especially to predict the strain-path sensitive deformation. 
The strain paths consisted of compressive loading in one direction and then compressive cross-loading in another direction while 
varying strain levels and strain rates. The loading tests were performed ex-situ, while the reloading tests were carried out in-situ under 
the high energy synchrotron X-ray diffraction. Procedures are developed to obtain texture, twinning, and elastic lattice strains from the 
diffraction data. 

The material shows significant strain rate sensitivity from 0.001/s to 5/s to 2000/s during the IP1 compression. The curves at high 
strain rate exhibit a sigmoidal hardening shape due to profuse twinning. Likewise, the cross-reloading is strain rate sensitive from 
0.0002/s to 0.001/s to 5/s. The strain rate dependence is attributed to slip mechanisms becoming increasingly more difficult to 
activate at higher strain rates, which is embedded in the thermally activate hardening law. Therefore, the increase in the flow stress at a 
given strain under high strain rate increases the activity of deformation twinning. The flow stress at the end of the pre-compressed 
material at 0.001/s is lower than the flow stress of the subsequent cross-reloading in the TT direction at 0.0002/s. Moreover, a 
substantial increase in the hardening rate arises upon the change from the IP1 compression to the cross-compression in the TT di
rection. However, the flow stress at the end of the pre-compressed material at 5/s and 2000/s is higher than the flow stress of the 
subsequent cross-reloading in the TT direction or the IP2 direction. The drop in the stress is followed by an increase in the hardening 
rate upon the change from the high strain rate IP1 compression to the quasi-static cross-compression in the TT direction. A small 
transient in flow stress and a low hardening rate characterize the strain-path- change from IP1 compression to IP2 compression, unless 
the IP1 compression was under high strain rate, which would cause a drop in the flow stress. It is shown that the model is able to 
capture these particularities pertaining to the complex strain-path-change and strain rate sensitive deformation of the material 
including the evolution of texture, twinning, lattice strains, flow stress, and anisotropic hardening with great accuracy using a unique 
set of single-crystal hardening parameters. 

Fig. 9 shows the predicted slip/twin activities associated with the predicted flow curves. The predictions are the average slip/twin 
activity considering all parent grains and twinned domains. The results reveal that prismatic and basal slip predominantly carry out the 
compressive deformation in the IP direction. The plots show a substantial extension twinning activity under 5/s and 2000/s strain rate 
pre-compression. Some pyramidal slip arising and a slight increase in the basal slip activity are due to the deformation of extension 

Fig. 9. Predicted activities of the prismatic (Pri.), basal (Bas.), pyramidal (Pyr.) and tensile twinning (TT) deformation modes for the selected 
preload and reload cases. 
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twinning domains. Comparatively, pre-compression at the lower rate 0.001/s shows much less extension twinning as shown in the 
evolution of texture and twin volume fractions. The cross-reloading deformation in the TT direction is characterized by basal and 
pyramidal slip and substantial de-twinning. Since de-twinning does not involve nucleation prior to growth like in twinning but simply 
reversing of the interface direction, resistance to de-twinning is smaller than that of twinning (Partridge and Roberts, 1964). As 
cross-reloading in the TT proceeds, the intensity of the basal planes formed along the IP1 direction is depleting and the twin volume 
fraction decreases. Cross-reloading in the IP2 direction is carried out by prismatic and basal slip and some twinning and de-twinning. A 
new intensity in the basal poles arises along the IP2 direction. As the cross-reloading in the IP2 changes the stress state in the grains 
with respect to the loading direction, the twins forming upon the IP2 cross-reloading are different variants from those formed in the IP1 
loading path. The measured volume fraction of twins after the secondary deformation step show similar content meaning that there is a 
balance of some twinning and some de-twinning. In summary, existing variants are decreasing in their volume fraction for the TT 
cross-reloading, while new twin variants are increasing in their volume fraction for the IP2 cross-reloading. 

Primarily due to the shifts in active deformation mechanisms, the MS-EPSC model captures the transients in the flow stress upon 
strain-path-changes. The mechanisms carrying the plasticity are different per path. The model successfully predicts the flow stress 
starting from the initial state of the primary loading to the end of the cross-reloading path for all tests. Therefore, the hardening 
behavior is predicted, in addition to the shifts in active deformation mechanisms governing the transient. The predictions of hardening 
during the strain-path-changes is primarily attributed to the flow of polarized or reversible dislocations (Kitayama et al., 2013b; 
Knezevic et al., 2013a; Peeters et al., 2001; Rauch et al., 2011) as well as twinning/de-twinning. The model formulation facilitate that a 
portion of the previously generated reversible dislocations annihilate during a reload to predict the hardening behavior. Annihilation 
of dislocations at a strain-path-change were confirmed by looking into the reductions of diffraction peak widths (Wilson and Bate, 
1986). Therefore, a decrease in dislocation density at strain-path-change is a phenomena that should be considered by the model to 
enable predicting hardening during strain-path-changes. 

The effect of reversible dislocation populations for the reversibility parameter of unity is shown in Fig. 10a. The figure shows a 
typical evolution of the dislocation densities with accumulated shear strain on a slip system. The easy motion and annihilation of 
loosely tangled dislocations in the opposite direction is facilitated by the high value of the reversibility parameter. As a result, the 
formulation mediates the issue of over-predicting of the hardening upon the strain-path-change. Fig. 10b shows that the increasing 

Fig. 10. (a) Simulated evolution of the dislocation density populations with accumulated shear strain in a randomly selected grain for a slip system 
with the highest activity: (0110)[2110] for A, B, K, and L, (1100)[1120] for C, D, E, and F, and (0001)[2110] for G, H, I, J, M, and N. (b) Simulated 
evolution of the total dislocation density with true strain during the loading and reloading. The values are summed over the slip systems in every 
grain and then averaged over the polycrystal. 

Fig. 11. Backstress with accumulated shear strain in the same grain and slip system as in Fig. 10a.  
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trend in the total dislocation density is a strong function of strain rate. Note that the hardening law formulation is strain rate and 
temperature sensitive. In the figure, only the total dislocation density governing hardening is meaningful because s+ and s- are not 
selected with respect to the loading direction but randomly. Therefore, only the total dislocation density is provided. The drop in flow 
stress arises regardless of the TT or IP2 strain-path-change after the high strain rate IP1 compression, which means that the glide of 
reversible dislocations is dependent on the cross-reloading pathway. Upon the initial changes in the dislocation density, subsequent 
dislocation generation is much more rapid in the TT direction along with de-twinning than in the IP2 direction along with twinning and 
de-twinning. 

Good predictions of the strain-path-change deformation behavior of Be results from a combination of several distinct physical 
phenomena incorporated in the model. The evolution of slip system-level backstress and inter-granular backstress are the remaining 
phenomena the model accounts for. Fig. 11 shows a typical buildup of intra-granular backstress on a slip system with shearing. The 
calibrated backstress law is approximate because the accurate calibration of the law requires load reversal or cyclic data, which are 
currently not available for Be. Therefore, the effect is regarded as secondary. The inter-granular sources of backstress fields are the 
interactions between individual grains of different crystal orientations. These effects are approximated in the EPSC model because 
every grain interacts with the averaged polycrystalline response unlike in full-field models in which grain-to-grain interaction are 
explicitly modeled. At zero applied stress, these inter-granular stress fields become residual stress fields. Fig. 12 shows a comparison 
between simulation results performed with and without residual stress. To obtain the predictions without residual stress, grain stress is 
set to zero at the zero overall flow stress after the pre-loadings. The inter-granular residual stresses effects after one strain path 
influencing the subsequent path are determined as small because the magnitude of these stresses is below yield stress of the material. 
From the comparison of the curves with and without inter-granular stresses, it is evident that the inter-granular stresses are slightly 
aiding plastic deformation in the subsequent path. Interestingly, the effect is directional being larger in the IP1 cross compressions than 
in the TT cross compressions. 

7. Summary and conclusions 

In this work, we have described the deformation behavior of pure Be during compressive loading and cross-reloading based on 
mechanical testing as a function of strain rate, in-situ high energy synchrotron X-ray diffraction characterization, and crystal plasticity 
modeling. Several procedures have been developed to obtain texture, twinning, and elastic lattice strains from the diffraction data. 
Mechanical response of the material has been measured ex-situ and in-situ for fourteen strain-path-change tests under several strain 
rates. The data shows a substantial increase in the initial flow stress and hardening rate upon the change from the IP1 compression to 
the cross-compression in the TT direction. In contrast, a drop in the stress and increase in hardening rate at the beginning of the second 
path arises upon the change from the high strain rate IP1 compression to the quasi-static cross-compression in the TT direction. A small 
transient in flow stress and a low hardening rate characterize the strain-path- change from IP1 compression to IP2 compression, unless 
the IP1 compression was under high strain rate, which would cause a drop in the flow stress. 

The comprehensive testing and characterization data sets are compared with the predictions of an EPSC crystal plasticity model 
termed MS-EPSC. The model incorporates several sub-models, namely, an advanced thermally activated dislocation-based hardening 
law, twin activation via statistical stress fluctuations, reorientation of one or multiple twin domains within a grain and associated stress 
relaxation, twin barrier hardening, and de-twinning. The studied material deforms by multiple slip modes having different resistances 
to activation and deformation twinning, thereby providing a challenging test for models, especially to predict the strain-path sensitive 
deformation. To better capture the strain-path-change deformation of HCP Be, the model is advanced in several aspects. The im
provements pertain to the incorporation of dissolution of dislocation population upon the load reversal, slip system level backstresses, 
and latent hardening. The model is able to capture the particularities pertaining to the complex strain-path-change and strain rate 
sensitive deformation of the material including the evolution of texture, twinning, lattice strains, flow stress, and anisotropic hard
ening with great accuracy using a unique set of single-crystal hardening parameters. 

While reproducing the data, the model adjusts the relative activity of slip systems for some strain paths and low strain rates, while 
hard versus soft slip systems and de-twinning or slip, twinning, and de-twinning for other deformation paths. From the comparison of 
the experimental data and predictions, we infer that these shifts in active deformation mechanisms are primarily responsible for 
transients in the flow stress from one path to another and hardening. For further verification of these observations, good agreement in 
predicting the evolution texture and twin fraction is achieved. Additionally, the evolution of elastic lattice strains compare well with 
the data measured in-situ using the high-energy x-ray diffraction. The secondary effects improving the predictions come from ac
counting for residual stress, slip system-level backstress, and latent hardening. We are confident to state that the advanced MS-EPSC 
model used in the present work can be applied to other HCP metals, deforming by multiple slip and twinning deformation mechanisms 
under a wide range of strain rate, temperature, and strain-path conditions. 
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Appendix A. Lattice strain analysis procedure performed using GSAS-II & MATLAB 

CeO2 Calibration in GSAS-II (Bright image file → Image controls)  

(1) Import bright and dark CeO2.ge2 files into GSAS-II (make sure each .ge file has the same exposure time at identical sample-to- 
detector distances).  

(2) Enter approximate values for beam center x + y and distance.  
(3) Enter exact value for wavelength.  
(4) Refine all calibration coefficients except wavelength (and possibly penetration).  
(5) Select dark image file.  
(6) Choose CeO2 SRM674b for a calibrant.  
(7) Set minimum D-spacing to 0.5 or 0.4 and pixel search range to 2 (if broad peaks increase to 5).  
(8) Calibration → Calibrate: left click on innermost diffraction ring in 5 or 6 different places then right click to calibrate.  
(9) Calibrate → Recalibrate until values don’t change.  

(10) Save CeO2 calibration file: Image Controls → Parms → Save Controls. 

Import & Integrate Be images (GSAS-II) 

Fig. 12. Comparison of true stress-true strain simulation results performed with and without residual stress (RS).  
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(1) Import dark Be.ge2 file and all in-situ loading bright Be.ge2 files into GSAS-II (make sure each .ge file has the same exposure time 
at identical sample to detector distances).  

(2) Select first Be bright file.  
(3) Load CeO2 calibration file.  

• Image controls → Parms → Load Controls: load CeO2 calibration file.  
(4) Choose dark image.  
(5) Check “show integration limits” and “Do full integration” under integration coefficients.  
(6) Choose appropriate azimuth (phi) and 2Theta integration limits (in this case −7.5:352.5 and 3.5: 10.3).  
(7) Choose number of bins: usually 2500 for 2Theta and either 1 or 24 for azimuthal bins (in this case 24).  
(8) Integrate histograms.  

• Integration → Integrate all histograms.  
(9) Delete image files from project. 

Single Peak Fitting (GSAS-II)  

(1) Select a pwdr data file with all peaks visible you want to analyze.  
(2) Peak List → Peak Fitting → AutoSearch: Manually add missing peaks and delete extra peaks.  
(3) Check refine box for position and intensity for all peaks. Peak Fitting → Peakfit.  
(4) Check refine box for sigma for all peaks. Peak Fitting → Peakfit.  
(5) Check refine box for gamma for all peaks. Peak Fitting → Peakfit (If this gives bad values, reset all values and repeat steps 3 + 4).  
(6) Uncheck all sigma (and gamma if that was refined) boxes. Peak fitting → SeqPeakFit (all histograms), then save project.  

• Depending on texture, sigma could possibly be refined in a second round of seq peak fitting. Gamma unlikely.  
(7) Export sequential data: load save with best refinement results → sequential results → Col/Rows → Save all as CSV. 

Lattice Strain Analysis (MATLAB)  

(1) Import load and position data from WAXS (or APS par) file and GSAS-II peak position data (including from virgin sample).  
(2) Convert load/position to true stress-strain and separate loading and unloading. 
(3) Select parallel and perpendicular planes from peak data (90◦/270◦ and 0◦/180◦ Φ (azimuthal axis)) and convert 2θ peak po

sitions to D-spacing.  
(4) Calculate lattice strains for each peak from D-spacing data (use virgin sample as initial) and associated error.  
(5) Couple lattice strain data to applied stress data.  
(6) Save compression stress-strain data.  
(7) Save lattice strain data for both parallel and perpendicular planes for each peak as a function of applied stress. 

Texture analysis procedure performed using MAUD, ImageJ, & MATLAB/MTEX: 
Initialize CeO2 image files in ImageJ for CeO2 Calibration  

(1) Convert CeO2.ge2 files to .tiff files.  
(2) Load dark and bright CeO2.ge2 files into ImageJ.  

• File→Import → Raw: 16-bit unsigned, 2048 × 2048 pixels, 8192byte offset, little-endian byte order.  
(3) Subtract dark from bright (Process → ImageCalculator) and save as .tiff. 

Import integrated CeO2_dkSub.tiff into Maud  

(1) Import files into Maud.  
• Dataset → datafiles → fromImages. ImageJ now pops up: File → Open CeO2_dkSub.tiff.  

(2) Set pixel dimensions in ImageJ:  
• Image → Properties: Units=mm, pixel dims=0.2.  

(3) Change other image parameters in ImageJ  
• Plugins → MaudPlugins → Multi-spectraFromNormalTransmission.  
• Enter approx. sample-detector distance.  
• Find center X and Y (change circle radius to match a diffraction ring for assistance).  
• Start: 0◦, end:360◦ (azimuthal angle, Φ), #spectra=72.  
• Click OK and save .eng file as original file name/number 

Manually alter diffraction instrument settings in Maud and import phase  

(1) Set Incident Intensity=0.01.  
(2) Set Intensity Calib: non cal.  
(3) Set Angular Calib: Flat image transmission → set: detector dist. 
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(4) Set Geometry: Image 2D.  
(5) Set Measurement: 2Theta.  
(6) Set Source: Synchrotron→set: wavelength.  
(7) Set Detector: Scintillation.  
(8) Set Instr Broad: Caglioti PV → set: all asym=0, HWHM 1 + 2 = 0, HWHM 3 = 0.0025, all Gauss=0  
(9) Enter computation range.  

(10) Add bk param if needed.  
(11) Import phase: CeO2.cif file. 

CeO2 Rietveld refinements to determine instrumental broadening parameters (calibration)  

(1) Refine: bk, scale.  
(2) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y).  
(3) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y), instr broad (all hwhf).  
(4) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y), instr broad (all hwhf, gauss 1).  
(5) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y), instr broad (all hwhf, gauss 1, gauss 2).  
(6) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y), instr broad (all hwhf, gauss 1, gauss 2), arb texture.  
(7) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y), instr broad (all hwhf, gauss 1, gauss 2, asym 1).  
(8) Refine: bk, scale, angular calib (detector dist, center x, center y, tilt x, tilt y), instr broad (all hwhf, gauss 1, gauss 2, asym 1, asym 

2).  
(9) Gauss 2, asym 1, and asym 2 may not converge, in which case do not refine.  

(10) Save instrument parameter file: create empty .ins file in appropriate directory, in Maud “store” instr param in that ins file. 

Initialize Be image files in ImageJ for Texture Analysis  

(1) Convert all Be.ge2 files to .tiff files.  
(2) Load dark Be.ge2 file into ImageJ.  

• File → Import → Raw: 16-bit unsigned, 2048 × 2048 pixels, 8192byte offset, little-endian byte order.  
(3) Load first bright Be.ge2 file into ImageJ the same way as the dark file.  
(4) Subtract dark from bright (Process→ImageCalculator) and save as tiff.  
(5) Repeat for all bright image files. 

Import integrated Be_dkSub.tiff files into Maud and Initialize for Texture Analysis  

(1) Delete CeO2 datafiles in dataset.  
(2) Duplicate dataset so the number of datasets equals the number of Be files to be imported (keeps calibrated instr params for each 

dataset).  
(3) Maud: Dataset → datafiles → fromImages. ImageJ now pops up: File → Open Be_dkSub.tiff.  
(4) Set pixel dimensions in ImageJ.  

• Image → Properties: Units=mm, pixel dims=0.2.  
(5) Change other image parameters in ImageJ.  

• Plugins → MaudPlugins → Multi-spectraFromNormalTransmission.  
• Enter exact sample-detector distance.  
• Find center X and Y (change circle radius to match a diffraction ring for assistance).  
• Start: 0◦, end: 360◦ (azimuthal angle, Φ), #spectra=72.  
• Click OK and save .eng file as original file name/number.  

(6) Repeat this process in new datasets for each Be file.  
(7) Enter appropriate rotation (ω) angles for each dataset (dataset → settings → modifyAngles: ω = ##◦).  
(8) Enter computation ranges for each dataset.  
(9) Add bk params if needed for each dataset.  

(10) Import phase: Be.cif file. 

Be Rietveld refinements to determine texture (remember to first fix all parameters before refining)  

(1) Refine: bk, scale.  
(2) Refine: bk, scale, basic (no Biso).  
(3) Refine: bk, scale, basic (no Biso, no lattice parameter), sample-detect dist.  
(4) Refine: bk, scale, basic (no Biso), microstrain.  
(5) Refine: bk, scale, basic (no Biso), microstrain, cryst size.  
(6) Refine: bk, scale, basic (no Biso), microstrain, cryst size, texture5 (E-WIMV, 7.5 deg res).  
(7) Refine: bk, scale, basic (no Biso), microstrain, cryst size, texture8 (E-WIMV, 7.5 deg res). 
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(8) Refine: bk, scale, basic (no Biso), microstrain, cryst size, texture10 (E-WIMV, 7.5 deg res).  
(9) Export ODF (beartex formated) 

Plot Pole Figures in MATLAB/MTEX  

(1) Make MTEX reference frame same as MAUD.  
(2) Convert ODF to Euler angle format and load/reconstruct using MTEX (7.5 deg res, 5 deg HW).  
(3) Rotate ODF +90◦ about IP2 axis and plot pole figures. 
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